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Learning Objectives

* Learn how to build complex underground tunnels using InfraWorks and Inventor.
* Learn how InfraWorks Tunnel Models integrate with Inventor, Civil 3D, and Revit.
» Discover lessons learned by HNTB.

* Learn what’s new and what’s next (Live Demo)

Description

This session will highlight the latest tunnel-design capabilities in InfraWorks
software, and how HNTB is adopting these new tools and workflows to design and document
complex underground tunnels for clients. See how Autodesk has been working with HNTB to
advance InfraWorks software's latest features in the tunnel-design process, and learn more
about its integrations with Inventor software, Civil 3D software, and Revit software.

Page 1 of 24



About the Speakers

Kyle Gerke is a BIM Manager for HNTB and has almost 10 years
of experience in the AEC industry. He also supports 3D
Visualizations for pursuits and has been a BIM Coordinator on
large scale Design Projects, including Water Treatment Facilities,
Airports and Bridges. His skills include software integration,
multidisciplinary modeling, clash resolution and creating
visualizations. His passion is to identify and utilize the best tools
available, focusing on automation and seamless integration, to get
the most out of a project model during all stages of design &
construction.

Scott Lecher is a VDC Systems Lead at HNTB with 20 years of
experience. Scott’s background is in roadway design and
parametric surface modeling to support delivery of plans, specs,
and estimates for construction documentation. Scott is also a
software developer proficient in automation and systems
integration. He is an ardent supporter of Open BIM for
infrastructure and enjoys bringing a data-focused mindset to
collaboration across the entire asset life-cycle from planning to
design and construction, then through handover to operations and
maintenance.

Ara Ashikian is a Senior Product Line Manager for the Autodesk
Civil Structures product development teams. Prior to joining
Autodesk in 2013, Ara gained over 20 years of experience as a
bridge engineer and a software developer. His experience
includes bridge design experience in preliminary, detailed and
construction engineering design aspects for a wide range of
bridge types. His projects included the detailed construction
engineering of the EG LNG suspension bridge in Africa, as well as
for the New Bay Bridge (self-anchored suspension bridge in
California), the detailed engineering for the launching of the
Kicking Horse Canyon in the Canadian Rockies as well as for the
cable-stayed Coast Meridian bridge.

Page 2 of 24



Table of Contents

Under the Radar: Complex Tunnel Design in INfraWorks ............ooooviviiiiiiiiiiiciicce e, 1
ADBOUL the SPEAKETS ... 2
........................................................................................................................................... 2
Learning Objective 2 — How To Build a Complex Underground Tunnel...............cccvvvvvvvieevnnnnnnns 4
BT o0 4
g 0 Yoo O ST 4
WOrKFIOW BreaKAOWN .......ccooiiiieeeee e 5
= 1Yo ) 1 PO PPPRPP 6
= o] TR T= ] 11 o O 7
BUild TUNNEI GEOMELIY ...t e e e e e e e 9
Learning Objective 3 — Infraworks Integration: Inventor, Revit, and Civil 3D.............ccccceeel. 10
Integration Workflow OVEIVIEW...........uueiiiiiii e 10
Inventor | Parametric Part ....... ..o 10
ReVvit INtegration SEIUP.......ccoo i e 15
(071 IC T I ) (=T =1 (o] o SRRSO PPPRRPR 20
Learning Objective 3 — HNTB LessoNns Learned...........ccoooieiiiiiiiiiiiiiiiieeeeeeeee e 22
Assessment of Integration Workflows | With InfraWorks .............cccccoiiiiiiiiii, 22
Assessment of Integration Workflows | Without InfraWorks.............oooviieeiiiiiiiiiiiiceen e, 23
Learning Objective 4 — Product Road Map & New Features.............c.ccooiiiiiiiiiiiiiiic i, 24
Learn what’s new and what’s next: the future of InfraWorks for tunnels. .................c......... 24

Page 3 of 24



Learning Objective 2 — How To Build a Complex
Underground Tunnel

Purpose

InfraWorks is best at quickly designing 3D horizontal infrastructure in-context, such as tunnels,
roadways, bridges, drainage systems, and surfaces. Given this ability and with its design tool
functionality rapidly advancing, particularly with tunnels, InfraWorks can start to be utilized as
the authoring 3D model platform. Also, the integration capabilities allow InfraWorks to connect
to software that is best at performing other tasks, like creating parametric parts or documenting
a set of drawings. Integration between vertical and horizontal models has not proven to be very
effective in the past but is starting to become a reality. Understanding the processes and
limitations described in this handout may help you determine what workflow is best for your
project(s).

Process

The diagram below shows the primary software connections that enable the workflow of
“‘Federated Design in InfraWorks and Document in Revit and Civil 3D.”

Federated Design

RVT
Horizontal Vertical
Design & Documentation Design & Documentation

o

Custom Parts
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Federated Design — can start with Model Builder to generate an existing geolocated
project that builds the terrain, roads, buildings, landscaping etc.

Horizontal — create an alignment from scratch in InfraWorks, or import external
alignment data that may already be developed to take over the horizontal design in

InfraWorks

Custom Parts — utilize parametric parts for quick tunnel editing (cross sections and
generic objects to place along tunnel alignment)

Vertical — publish civil structure and import the IMX into Revit & Civil 3D to create

construction documentation

Workflow Breakdown

The chart below shows some additional design applications and the integrated purpose they
may serve in the federated design model. For example, Inventor for creating parametric content,
Revit for documenting sheets and modeling rebar, etc.

Base Files
Civil 3D & MicroStation

Alignments
Existing Survey
Proposed Terrain Models

Arch GIS Pro

Existing Terrain Models
GIS Models

Nearmap, Recap Photo

High Res Imagery

Sketchup, Revit, 3DS Max
Building Models

Point Cloud,
Photogrammetry

Existing Scans

Federated Design

InfraWorks

Design Proposals

Supplemental Design

3DS, Revit & Inventor

Custom Parametric Content

Documentation

Revit

Alignment Plans
Rebar
Schedules

Civil 3D & AutoCAD

Show federated
geometry in model / on
sheets

Clash Detection

Translator for federated
geometry

Visualization

Twinmotion, Lumion,
BeyondCAD

High Quality Graphics
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Payoff

A federated InfraWorks model provides many added benefits. Here is a list of some of the
benefits of modeling in InfraWorks:

Advanced in-context modeling: before you even start proposed modeling, InfraWorks
can build your existing project site with model builder. 3D buildings, bridges, roads, and
terrain are generated and can be modified if needed. Multiple proposals can be modeled
in a workshare environment, and geometry can be added from the large library of Civil
components or imported from external software and editable within InfraWorks.

Better coordinated models: real-time 3D review can occur during all stages of design
for better decision making. InfraWorks models are viewable in the ACC model viewer
and can be brought into Navisworks for clash detection.

Visualization Benefits: impress stakeholders with presentation graphics and
walkthroughs that can be created inside InfraWorks! Many 3D Visualization platforms
are oriented around Architecture but with storyboarding, infrastructure animations can
live right inside your in-context modeling platform.

Integration and Data Exchange Capabilities: export to advanced Visualization
applications like Twinmotion, Lumion, and BeyondCAD. You can export data to excel to
quickly update attributes. You can utilize the Civil Structures connections to bridge the
Civil 3D and Revit data exchange gap. InfraWorks is ideal for integrating vertical and
horizontal information. See image below for some of the file types that can be brought
into the platform:

Groupby:  Feature Type ¥  Show:

In addition to integration options shown in the
workflow breakdown chart, this image shows data
sources that can also be brought into InfraWorks.

SQLite

- SketchUp

Keep in mind, you can bring external files into InfraWorks at any stage of your design to take
advantage of some of these added benefits, even if InfraWorks isn’t being used as the authoring

model.
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Infraworks Setup

Typically, proposal models will utilize Model Builder to build an existing conditions start to your
project model (created from OpenStreetMap and other data sources).

Option 1: From the Infraworks home page, select the “Model Builder...” option. You will then be
prompted to search a location, and select the extents of the 3D modeled environment.
Depending on the coverage location, the accuracy of terrain, roads, and buildings may be at a
rudimentary level. Importing Survey data will give you the most accurate terrain, but is not
always available during the early stages of design. You can check out these free Global Data
Source sites for additional DEM terrain data (Digital Elevation Models) Link

Option 2: If you create a model by selecting the “New...” option from the Infraworks home
page, then you will start with a blank model environment, without any existing terrain, buildings,
or roads on your site. (QGIS, ArcGIS)

Setting up Coordinates

Make sure to select the appropriate coordinate system when setting up your model,
since this cannot be changed after your model has been created. This will establish the
geolocation so you can import data that has the same coordinate system.

1 Model Builder [m] x

e e
2 SEARCH LOCATION & || p—
SET EXTENTS '

SET COORDINATE Site 1183 £F
SYST E M Coordinate System

cate this

Model Builder...

Recent

Autodesk Docs
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Import Alignment & Inventor Part

As with most linear projects, the tunnel workflow typically starts with horizontal and
vertical alignment. Although the alignment can be created and modified within
InfraWorks (as a component road), typically, the data originates in Civil 3D or
MicroStation. For this workflow, we recommend the design team imports any external
alignments that have been developed and take over that design in-context of InfraWorks.

| created a couple Screencasts to run through the process of building a tunnel. The first
video can be viewed here:

Knowledge Network Video: InfraWorks + Inventor Process

This video captures “How To”:
» Importing C3D data source (alignment with vertical and horizontal data)
» Configure and filter out excess alignment and corridor (comes in as a road)
* Add tunnel structures to road
* Import parametric part into style palette
* Assign domain and component type to tunnel segment
» Confirm parameters were translated
* Modify horizontal and vertical alignment (hold Alt to keep constrained)

Not shown in this video is switching between different types of tunnels. Here are some
screen captures that show the defaults:

submerged tunnel

bored tunnel
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Build Tunnel Geometry
This second video shows how to modify the tunnel further to achieve various complexities.

Knowledge Network Video: InfraWorks Slices and Generic Models

This video captures “How To”:

» Create, copy, duplicate tunnel cross sections / slices

» Adjust parameters of tunnel segment directly in InfraWorks user interface (allows
for variation in tunnel geometry at specific linear alignment stations)

» Add generic objects along alignment

» Skew, group, and offset objects

» Export tunnel data to excel to manage parameters externally (add slices and
manipulate data)

No Shown in this video is how to setup the connection. Once you’re ready to bring the
tunnel into Revit and/or Civil 3D, select the tunnel, right-click and select Publish Civil
Structures. Then specify a location to place your IMX file that can be brought into Revit
and Civil 3D:

Quantities...

k| Create New

Refer to the Revit Integration Setup Section in the next Objective for next steps to
documentation in Revit.
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Learning Objective 3 — Infraworks Integration:
Inventor, Revit, and Civil 3D

Integration Workflow Overview

In the previous section we went through the purpose, process, payoff, and setup in InfraWorks.
In this section we will go into some detail on how to setup the dynamically integrated connection
with Inventor, Revit, and Civil 3D. This will enable parametric model control within InfraWorks
and documentation outside of InfraWorks.

Inventor | Parametric Part

InfraWorks can read Inventor parts and assemblies along with any parameters specified for
in-context control. First, create a 2D sketch, and add extrusions based on the level of detalil
required. Then set “key” parameters and iLogic rules using features and formulas create a
parametric part. Let’s review the process.

Create your sketch — make sure all dimensions are fully constrained:
(Note: this can be done before or after you setup the user parameters, shown in the next step)

B H - Oh-B-98 ] -8 QS s Autodesk Inventor Professional 2023 Tunnel Slab
Bl skech IR ents  Add-Ins  Collal [of
— T y 1 Fillet = ¥ 4 Move % Trim ] Scale Rectangular 4+ | ) @ & image = V
= |. L C A Text - Y Copy - Extend [\ Stretch 22 Circular (4 = 4| B8 Points ' .
Star Line Circle  Arc Rectangle Project Dimension = Finish
2D Sketch ™ v v t Point Geometry” () Rotate Split Offset A\ Mirror [ & ) = I acaD  EE show Format  Sketch
" S .
del G- Q=

fxfl1 = Roof _SLAB_THK

Sketch3

frdid = lodle.lB_‘I'HK_Z

i

#x:d10 = TopFirZTopRoof

Hd27 = APMN_Cell W———————————om]
fi:cd28 =| APMN_ExWl THK
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Create your parameters: (make sure to check the “Key” parameter box to be able to control
the dimension within InfraWorks)

Parameters x
Parameter Name Consun Un Equation  Nominal | Driving  Toler & Model Vaie Key PEExport P Comn

| +| Model Parameters -
» | -JUser Parameters

- TopFr2TopRoof [d10  |ft |25ft 25.000... O 12 r

{Roof_SLAB_THK [fl1 it |3ft 3.000000 O 3.000000 || F r

Roof_sias_THK...|d14 [ [1Ft 1.000000 O 1000000 |7 F

|HAS_SLAB_THK_2 T. Tue ~ | |

secure_Fr_THK |d19 |rt |3t 3.000000 O [3.000000 || F r

| lsecure_Lwail 0. |a24_|rt |26t 26.000... O [26.000000) # =

- Secure_RWal_0...[d25  |it |26ft 26.000... O [26.000000) r

LiSecure_Lwal_T... |d20 |ft | 15Tt 1.500000 O |1.500000 | r

secure RWal T...[d21 [t [1.5Mt 1.500000 O [1.500000 |7 r

HAPMN_Fr_THK |26 |rt [3ft 3.000000 O [3.000000 |7 r

HAPMN_Cel W |d27  |R 180" 18.000... O |18.000000) F r

- APMN_Exwal_T...[d28 it |31t 3.000000 O [3.000000 ||F r

apMn_fr_offset |d2e R [Oft 0.000000 O o.000000 | F rC

HAPMS_Fr_THK  |d33  ft [3ft 3.000000 O |3.000000 |F r

APMS_CelW  |d35  |ft |18-0" 18.000... O 18.000000) r

- APMS_ExWal_T... [d36  |R |3ft 3.000000 O |3.000000 | F r

- APMS_Fr_Offset [d34 it [4ft 4.000000 O a.000000 |[F r

- Has_Roof_Sab T.Te - | |

- Has_Secure FIr_... T. Tue ¥ |7

- Has_APMN_F_... T. Tue ~ | |

- Has_APMN_wal_L T. Tue v | 1L

+{Has_APMS_Fr_S... T. Te | I

| Has_apMs_wal_R T. Tue - I

| Has_Secure_Wa... T. Tue * IF

Has_Secure_Wa... T...| True = I\F

! Has_Maintenanc... T.|Fase = |2

| P — T [ The - - A
¥ AddWumeric |v | update Purge Unused £+ Import fi ggget Tolerance << lam
] Link [Jimmediate Update 7 epote T (A O —

Tip: If you create all parameters up front, you can assign to dimensions as you go, or once all
dimensions have been added. Just right-click each dimension to assign to a parameter.

Create an Extrusion from your sketch. 3D Model Tab > Extrude, then select a closed face:

o

Start .
2D Sketch

BHS 6

3D Model

Extrude Revolve gl

Sketch  Anme

E«

Sketch
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Add an arbitrary thickness so your .ipt file can be recognized when imported into InfraWorks:

Properties X 4

Roof Slab > Sketch3

¥ Input Geometry

Profiles k [ 2 Profiles o
\ From & 7 1 Sketch Plane I
\ ¥ Behavior

. Direction b / W -

SN . \

¥ Qutput ™

LH

Body Name Solid1

» Advanced Properties

oK Cancel -+ \
NI

Important: make sure your parts / assemblies have a consistent UCS orientation as well
as consistent extrusion direction in relation to the XYZ plane. This will ensure they are

accurately brought into InfraWorks.

Advanced Parameters (iLogic). A common need when modeling is the ability to control what
and when things appear. For example, you may need to control the visibility of an object, or only
show one object visible, if another object is also visible. This can be a bit tricky to setup since it
requires manipulating code. Let’s review the setup for an Inventor part, which is similar for

assemblies.

First, add a True/False Parameter: (Check “Key” box)

Mao_JOULUC_vvon_L Ne NUE II'
i Has_secure_wal_R T.| True i
-~ Has_MaintenanceWalk_N T. Fase ¥ W
| Has_MaintenanceWalk_S T.True ~
oo
4 Update Purge Unused = Import fr geset Tolerance << Less
Add Numeric A &=
LT,J e Update f; to + et
et o Expor

I Add True/False ||
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Next, add logic built from parameters and sketched parts.
Select the iLogic Tab > Add Rule:

IID-BE@- -5

BN 3DModel | Sketch  Annotate

—| S B sweep
149 () & Lo
Start Extrude Revolve

2D Sketch ™ = coil

Sketch Cre:

[modff Logie X+ —
Rules orms | Global Forms | External Rules

(™ Tunnel Slab
£ HAS_Feature
T HasaPM_Chamfer

Paste Ctrl+V

Run All Rules
Regenerate All Rules

&

Add a True/False rule, refer to any row of code below: (see red text for code breakdown)

= Edit Rule: HAS_Feature

Snippets P Model | Options | Search and Replace | Wizards

¥ (® Tunnel Slab ramet
System | Custom e Parameters | Names

fr Model Farameters

. Q Parameter Equation
ra fx User Parameters H H
» [7] Parameters 3 éuoud States: [Primary] ILoglc (gets part)
v B Fostwes > Toe View: Primay] Name of Extrusion

» 1e, ucs1

Key Parameter

o mp Sz e l:_T - Keywords -/Operators - Header... @

Get or set activity of a feature

Feature.IsActive( featurename"”

) ThreadClass 3 Feature.IsActive("Roof Slab™) =_
) IsActive(Ass'y) a
) Color (Ass'y) 5 Feature.IsActive("SLAB_THK_2") = HAS_SLAB_THK_2
{-} SetThread All (Ass 6
() ThreadDesignation 7 Feature.IsActive("Maintenance Walk_N") = Has_MaintenanceWalk_N
() ThreadType Read | 8
() ThreadClass (Ass'y 9  Feature.IsActive("Secure Flr Slab™) = Has_Secure_Flr_Slab
» [ Components (classic) 18
. - “APMN F .y -
» B Wogc blles/Comy 11 Feature.IsActive("APMN Flr Slab") = Has_APMN_Flr_Slab
- 12
» [11 Positioning . . .
13 Feature.IsActive("APMS Flr Slab") = Has_APMS_Flr_Slab
» [ iProperties 14
» [2 Excel Data Links
» [ iParts
» [ iFeatures Ln 26
» [ Relationships (classic)
Log Level Info - taile € Save Save & Run

] X

» o

Col 32

Cancel
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Here is an example that breaks down the code use in “If / Then” formulas:

Log Messages 18 If APMN_Flr_Offset > @ ft Then

) . .

1 iLogic (gets part)
12 Feature.lsActive("APMN Flr Chamfer") = True

Run Other

som End If

Math

Strings
Variables

Ll Col 2
Sheet Metal

& Edit Rule: HasAPM_Chamfer m X
Snippets Model | Options | Search and Replace | Wizards
v Paramet
Systerr Custom (®™ Tunnel Slab Parameters | Mames
fr Model Parameters Parameter Equation
0, f "
. T User Parameters
, > B Model iates: (Prinany] Key Parameter
» Features * __'_'- View: [Primary] '
> Components (classic) » T, ucs1 Eq uatlon txt
» iLogic Assemblies/Comp Sketch3
» Fositioning B XDID e == [ ¥..Then..End ¥ #Keywordg - Operators = Header... (7)
» iProperties 1 | +
(3 Excel Data Links 2
» iParts 3 If APMN_Flr_Offset = @ f& Then
» iFeatures 4
» Relationships (classic) 5 Feature.IsActive("APMN Flr Chamfer") = False
> Relationships (Add)
> Measure End If
> Forms E i
Name of Extrusion
» MessageBox
>
>
>
>
>
>
»
>
>

Dirawin
- Log Level Info - y Save & Run Close

Note, there is no need to assign iLogic rules in the parameters window, the association happens
in the code.

You can now save you. ipt or .iam file for use in InfraWorks!

If you would like to learn more modeling techniques in Inventor, see the links below. These
videos have some good tips and go into detail that was not covered in this section.

External Resources:

60 Inventor Tips in 60 Minutes | AU 2017
Inventor iLogic: Beyond the Basics | AU 2017
Autodesk Knowledge Network — Inventor Videos
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Revit Integration Setup

Once you have created the Civil Structure IMX export, you are ready to bring the file into Revit &
Civil 3D and start creating your construction documents. Place the IMX in a central location so it
can be overwritten when updated, to allow for dynamic connection in Revit. It will then be
utilized to show in plan views, elevations, sections, and schedules. Revit can also be used for
modeling and documenting rebar. Let’s review the process in Revit.

To enable Infrastructure tool, go to the File Tab > Options > User Interface:
Then make sure the box is checked.

Options X
General Configure
Tools and analyses:

User Interface

v Mechanical analysis tools ~
Graphics ¥ Systems lab: electrical tools

v| Electrical analysis tocls
Hardware ¥ Systems tab: piping lools

«| Piping analysis tools
File Locations

¥ Massing & Site tab and tools
Rend v Energy analysis and lools
r
endenng ¥ _Route analysis and tools
Check Spelling I v Ilnfrasuuclure Tools
W
SteeringWheels
Keyboard Shortcuts: Customize...
ViewCube
Double-dick Options: Customize...
Macros
Tooltip assistance: Normal fa
Enable Recent Files List at Home
Ribbon tab switching
After clearing a selection or after exiting...
Froject Environment:  Return to the previous tab -
Family Editor: | Stay on the Modify tab ~
[] Display the contextual tab on selection
View switching
Ctri+{Shift)+Tab: | Tab position order o
Visual experience
Active theme: | Light i

[[Juse hardware graphics acceleration if available

e || o
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There is now an Infrastructure category option:

Show model categaries in this view

Category name search:
Eilter list: <show all> w

Visibility/Graphic Overrides for Structural Plan: OVERALL TUNMEL LEVEL LAYCOUT PLAN

Model Categories  Annotation Categories Analytical Model Categories Imported Categories Filters Worksets Design Options

T a cateqgory is unchecked, it will not be visible.

[ Architecture

] Structure Projection/Surface Cut Halfiome Detail
_Z Mechanical Lines | Patterns | Transparen... Lines Patterns Level
© ¥ Aoutftearcs  Demide.. | Ovemide.. | Ovemide. | Ovemde.. | Overide. | (] By View
+ ¥ 111 | | | By View
s | By View
o Audio Visual Devic... O By View
+- ¥ Bearings O By View
¥ Bridge Cables | By View
4™ Bridge Decks O By View
+ ¥ Bridge Framing O By View
i ¥ Cable Tray Fittings O By View
+- ¥ Cable Trays O By View
# [ Casework ] By View
+-[] Ceilings O By View
£ ¥ Columns || By View
¥ Communication D... O By View
+ ¥ Conduit Fittings | By View
+ ¥ Conduits ] By View
4 Curtain Panels O By View
+- L] Curtain Systems O By View
£ L] Curtain Wall Mulli.. | I— a By View
Al None Ivert Expand All Override Host Layers
[[]cut Line Styles Edit...
Cogures bt re  vrtden 1 vt | G s
Concel  opy

This option enables infrastructure categories such as abutments, piers, expansion joints, and
bridge decks. Subcategories and annotation categories including alignments, station labels, and
tags for infrastructure model elements are also available.

Now that we have setup the infrastructure tools, let’s bring in the InfraWorks model.
Navigate to the Add-Ins Tab > Import Civil Structures:

wutodesk Revit 2023 - Tunnel Structure Doc_Example.rvt - Sk
Manage Add-Ins  Revizto 5 Quantification Is

? | B)C|E

tamodel About Import heck for J| Category
Civil Structuresll Updates Mapping

eTransmit Civil Structures
Import Civil Structures

X Import Civil Structures

Press F1 for more help

Note, when the IMX file is updated by the tunnel designer, you can select “check for updates”

shown above.
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The IMX import will translate to generic models and will be selectable based on how the IPT /
IAM file was built. Below is an example of the properties that are brought over when selecting
the roof slab.

Properties

"

Generic Models (1) =
Materials and Finishes

material testing

Structural
Design_Element_Weight
Rebar Cover Rebar Cover 1 <0 - 17>
Estimated Reinforcement Volume {7011.31 in”

Identity Data
Image
Comments
Mark

4, Building
B Zone
_Elevator Type
HNTB_Cost Code
HNTB_Cost Description

Workset TNL - Structures

Edited by kigerke

Design Option Main Mode
Phasing

Phase Created Existing

Phase Demolished MNone
IFC Parameters

Export to IFC By Type

Export to IFC As

IFC Predefined Type

IfcGUID 2csVPsq 1fFpRunGCOXgAY

Annotation tools — below shows how Civil Structures supports tags, dimension, and creating
station labels. You will find the labels within the Annotate Tab > Alignment Station:

>

Alignment
Station

} Alignment Station

i,
_,J Alignment Station Set

TUNNEL
SHELL

STA 326+00.00
STA 327+00.00

96' - 6"-—%\\ —+ | |STA 325+00.00
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Below is an example how the tunnel is displayed in both cross and longitudinal sections. These
dimensions will update accordingly if / when design changes occur.

+NTE
_\.\\ (H % ]
4 TYFIGAL CROSS SECTION .
- -

WA - ""'."-""'Jl == :
| =
|
| —

. T [
o i
zmmm
i ssko2 |}
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Revit schedules also support Infrastructure categories:

Mew Schedule *

Category name search:

Filter list: | Infrastructure w

[ |Architacture
Cate = Name:
Cand [ |Structure -
MU= achanical # | Multi-Category Schedule 2
+ Abu—

| |Electrical

Ali I Pipin: Schedule bullding companents

At.

Al | Infrastructure | Schedule keys

Bearings

Bridge Cables

Bridge Decks
+| - Bridge Framing Phase:

Detail ltems

Expansion Joints

Fire Protection

Food Service Equipment ¥
< >

o] ome |

Currently, since tunnels are recognized as generic models, the infrastructure schedule can not
be utilized. Here is an example of a quantity take off for generic models:

MNew Construction L

Multi-Category Material Takeoff
Category | Materiat Area | Material Name | Material: Unitweight [ Material: Volume Comments
Floors 182551.50 SF Default Floor 0.00 Ib/ft 2129799.08 CF FUTURE
Generic Models 3107950.27 SF Bridge Concrete 0.00 Ib/Aft 4397799.81 CF TUNNEL SHELL

Free Form Rebar

This video shows the process for adding associative 3D rebar to Civil Structure
components.

Autodesk Knowledge Network: Free Form Rebar
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Civil 3D Integration

Currently, the integration functionality in Civil 3D is very limited. You are unable to see Civil
Structures in a cross section or profile view, so utilizing Civil 3D for documentation is not a
feasible option; You are only able to import the IMX to show on plans and in model space.
Although, you can use Civil 3D as the “middleman” for bringing an IMX into a DWG, then into
Navisworks to run clashes. Here is an Autodesk demo that show how you can utilize the Model
Coordination module inside ACC to perform clash detection: Clash Detection Process (IMX to
DWG to ACC)

To bring in the IMX, go to the InfraWorks tab > Import IMX:

I

DOpen Mode| Import IM>

it IMX  Product Page

Export Learn

Note, make sure coordinate systems align if you already have the Civil 3D model created.

Notice, there is not “Check for Updates.” This feature is not available in Civil 3D. Layers and

objects are brought over as disconnected / exploded elements.

AU_Alignment_Example*

| HE

InfraWorks Object
Terrain Surfaces
Planning Utilities
Flanning Roads

Design Roads
Component Roads

[+#] ntersections

Drainage Networks
Coverages (Terrain Modifying)
Water Areas

Bridges

Roundabouts

ETunnels

Generic Objects

InfraWorks

Civil 3D Object Settings
TN Surfaces

Fipe Netwarks

Alignments

Alignments and Profiles
Corridors and Assemblies
Intersections with Curb Returns
Fipe Networks
Lo
[o

Bridges
[0

0

|0

oK Cancel

Help
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To edit what objects are brought into Civil 3D, select Exchange Settings, and check the
boxes on the left side. (Shown on previous page) To edit how Civil 3D objects are
recognized when brought into InfraWorks, select the three dots for each element

category, shown on previous page, then adjust settings:

E Planning Utilities to Civil 30

Civil 3D Fipe Network Catalogs
Catalog folder:

Pipe catalog:
uS Imperial Pipe Catalog

Structure catalog:
US Imperial Structure Catalog

Pipes
Styla:
Standard
Layer:

C-FIPE

Structures
Style:
Standard

Layer:

C-PIPE-5TRC

[ o ]

Cancel

Help
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Learning Objective 3 — HNTB Lessons Learned

Assessment of Integration Workflows | With InfraWorks

Since the ability to design and integrate civil structures is fairly new, there are some limitations
with the workflow. The limitations listed below are items we believe would greatly improve both
modeling and documentation. Note, many of these limitations will no longer exist with the next
InfraWorks release! (See learning Objective 4)

Limitations | Translation to Revit

1. You cannot modify Civil Structure geometry once it has been brought into Revit. For
example, cutting voids or joining Revit geometry with imported civil structure geometry is
not currently an option.

2. Category Mapping is limited to generic models for tunnels, which limits visibility graphics
control and prevents accurate category assignment best practice.

3. Limited Type Parameter control. With the type parameter “grayed out”, you can’t
generate type parameters such as keynote tags or utilize interoperability tools to push
UniFormat / Master Format classification codes to civil structures.

4. Station offset labeling is not available. You are only able to add station labels and
Northing and Easting notation along the alignment.

Limitation | InfraWorks Modeling

1. You cannot “check for updates” of an import Inventor part for a tunnel segment in
InfraWorks. The feature is “grayed out”, which requires you to import a new IPT and
swap that tunnel segment, removing all manually placed cross sections.

2. Inventor learning curve. Tunnel designer needs to be proficient in both InfraWorks and
Inventor for this workflow to be efficient. (Complex geometry in Inventor requires a good
understanding of formulas, equations, assemblies, iLogic, etc.)

3. Cannot place an alignment on top of another alignment in InfraWorks.

4. Placement of objects must be relative to an alignment. You are not able to associate
InfraWorks generic models based on other geometry or parameters within that
geometry.

5. Visibility of Tunnel within cross section view. When you go to the cross-section viewer in
InfraWorks, you can only toggle features such as roads, topography, and drainage.

6. Cannot change material of slice-based geometry in InfraWorks. This would need to be
added as a shared parameter on the revit side. (Due to locked type parameters)
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Assessment of Integration Workflows | Without InfraWorks

We also investigated some alternative options for tunnel modeling that do not involve the use of
InfraWorks or Inventor. These workflows have some disadvantages and pre-requisites, namely
requiring a strong programming background and mindset. Here is an overview of each workflow
along with our finding, but we encourage you to investigate further based on your project needs.

Connected Workflow (presented at AU 2019)

This process involves extracting excel data from a Civil 3D corridor to duplicate into revit as
geometry & Dynamo scripting to update models via feature lines and point codes, connecting
Civil3D subassembilies. Corridor reporting is then used to generate and Excel sheet of northing
and easting coordinates by station. Dynamo was then used to generate linear and point
geometry from the Excel data, as well as to create the Revit geometry itself.

More info: Connected Bridge Design | Autodesk University 2019

CivilConnection “Linear Structures Workflow”

In this workflow, data is exchanged using custom Dynamo nodes and graphs. It is available as a
github project that contains the source code itself as well as the compiled Dynamo nodes. This
workflow utilizes subassembly shapes from a Civil 3D corridor to generate lofted geometry in
Revit. This workflow can also utilize an IFC-based workflow where corridor solids are created in
Civil3D and then linked to Revit via an IFC export.

A disadvantage, for both the Connected Workflow and CivilConnection, scripts developed for
one project likely won't translate to another given the nuances within the code and varying Civil
3D sub-assemblies between tunnel types. For example, say a design iteration occurs to the
tunnel cross section; updating may require recreating point codes / sub-assemblies and
rewriting scripts, rather than updating an Inventor part and simply ‘checking for updates’ in
InfraWorks.

More info: Linear Structures Workflow Guide

Speckle Connectors

This platform does open-source data sharing at the object (not file) level. They have developed
a plug-in for various design apps, that utilize a cloud based central model for translating data
and can be synced between software. Speckle connectors are fairly new and still need some
work to be utilized as a dynamic link between Civil 3D and Revit. Some issues we found
include: cannot map categories in revit, cannot setup Shared Coordinates, and mixed results
with 3D appearance when updating / syncing. Speckle aims to be the “git” of AEC and uses
workflows from software development such as branches and commits. It reads binary data from
multiple software packages such as Revit, AutoCAD, Blender, and Rhino and serializes it to a
neutral representation that can be exchanged via APl as JSON or stored in a database.

More info: https://speckle.systems/
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Learning Objective 4 — Product Road Map & New
Features

Learn what’s new and what’s next: the future of InfraWorks for tunnels.

During the in person live demo we will review these new features:

Clipping Planes

Revit Families as Civil Structure Content

Revit Category Mapping for Inventor Parts
Enhanced geometry control for piers and abutments

For more information and to keep updated with all things InfraWorks, here is a link to the
Autodesk product page: InfraWorks Product, Capabilities, and Features
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